Using Outlook 2000 with Exchange Server in the Connecticut Community College System

Custom Training for Faculty and Staff

Customized documentation developed exclusively for the Community College System by
Dale Burns, 860-741-6080, daleburns3@hotmail.com

Questions or comments about this documentation?
Contact: Tobi Krutt, Manager of Technological Tools & Training
System Office, Connecticut Community Colleges
tkrutt@commnet.edu or 860-725-6637

July 2001  Version 1.0

Copyright ©2001 BOTCTC Connecticut Community College System
Acknowledgments

Microsoft® Outlook for Windows® 2000
Course edition: 1.0
For Outlook 2000 Version 9.0
Exchange Server Version 5.5
# Table of Contents

**ACKNOWLEDGMENTS** ........................................................................................................................................ 2

**USING OUTLOOK 2000 WITH EXCHANGE SERVER** .................................................................................. 5

**COURSE PREREQUISITES** ......................................................................................................................... 5

**OUTLOOK AND EXCHANGE SYMBOLS** ..................................................................................................... 6

**UNDERSTANDING THE ADDRESS LISTS** ................................................................................................ 7

- Difference between the Outlook Address Book and Contacts ............................................................ 8
  - Display the properties of someone in the GAL .................................................................................. 8
  - Add a person in the GAL to your Personal Address Book (Contacts) .......................................... 8
  - Display a list of individuals stored in your personal Contacts ...................................................... 9

**CONTACTS** .................................................................................................................................................. 11

**CATEGORIES** ............................................................................................................................................... 12

- Create a new category ......................................................................................................................... 12
- Create a new contact and add it to a category ................................................................................. 14
- Send an e-mail to everyone in a category ..................................................................................... 15
- Create a new contact from the Outlook Address Book .............................................................. 18

**DISTRIBUTION LISTS** ............................................................................................................................... 21

- Create a new distribution list in your Contacts ........................................................................... 22
- Show the members in a personal distribution list ........................................................................ 24
- Create and send an e-mail message to a distribution list ............................................................... 25
  - Distribution Lists vs. Categories .................................................................................................... 27

**USING ADVANCED INBOX FEATURES** ................................................................................................ 28

- Tracking when messages are delivered or read ............................................................................... 28
  - To be notified when all messages are delivered ......................................................................... 28
  - To be notified when only one message is delivered or read ....................................................... 30
- Message recall .................................................................................................................................... 31
  - Recall or replace a message you have already sent .................................................................. 31
- Using the Out Of Office Assistant .................................................................................................. 32
  - Activate the Out Of Office Assistant ............................................................................................ 32

**CONDUCTING A VOTE** ............................................................................................................................ 34

- Adding voting buttons to your e-mail message ............................................................................. 34
- Reviewing survey responses ............................................................................................................. 36
- Tracking survey results ..................................................................................................................... 36

**OUTLOOK WEB ACCESS (OWA) OVERVIEW** ......................................................................................... 38

- Logging on to Outlook Web Access ................................................................................................ 39
  - Web Browser Specifications for OWA ............................................................................................ 39
- View your folders in Outlook Web Access ..................................................................................... 42
  - The Outlook Web Access toolbar ............................................................................................... 42
- Changing pages .................................................................................................................................. 43
- Delete e-mail messages .................................................................................................................... 44

**OUTLOOK 2000 FOLDER PERMISSIONS** ................................................................................................. 45

- Assign delegate access and folder permissions .............................................................................. 46
  - Granting permissions to a delegate ............................................................................................... 46
- Send a message as a delegate ........................................................................................................... 50
- Open a coworker’s calendar ............................................................................................................. 52
ASSIGN OR DENY A DELEGATE PERMISSIONS TO YOUR CONTACTS......................... 52

SETTING FOLDER PERMISSIONS ........................................................................ 53
SHARE A FOLDER WITH COWORKERS .................................................................. 53
REVOKE FOLDER-SHARING PERMISSIONS FOR A COWORKER............................ 56

USING THE CALENDAR .................................................................................. 57
SCHEDULE A PRIVATE APPOINTMENT................................................................. 57
SCHEDULE A RECURRING APPOINTMENT ........................................................... 59
CHANGE THE VIEW OF APPOINTMENTS ............................................................ 60
SCHEDULE A MEETING...................................................................................... 60

DETERMINE THE SIZE OF AN OUTLOOK FOLDER............................................ 62

ARCHIVING OUTLOOK FOLDERS ..................................................................... 64
TURN ON AUTO_ARCHIVE .................................................................................. 65
SET AUTO_ARCHIVE PROPERTIES FOR A FOLDER ............................................ 65
RETRIEVE ARCHIVED ITEMS .......................................................................... 65

CREATING RULES TO AUTOMATICALLY ORGANIZE AND MANAGE YOUR INBOX........................................................................................................ 67

MOVE SENT MESSAGES TO AN ARCHIVED FOLDER UPON RECEIPT ............... 68
AUTOMATICALLY MOVE OR DELETE ITEMS IN AN OUTLOOK FOLDER AFTER A SPECIFIED PERIOD OF TIME................................................................. 72

CREATE A PUBLIC FOLDER .............................................................................. 74
SHARE A SCHEDULE, CONTACT LIST, OR TASK LIST IN A PUBLIC FOLDER ....... 74
Share a task list.................................................................................................. 74
ADD AN EXISTING ITEM TO A PUBLIC FOLDER .................................................. 74
Post information in a public folder..................................................................... 75
Post a reply to information in a public folder..................................................... 75
Using Outlook 2000 with Exchange Server

Outlook 2000 is designed for individuals who require a level of communication beyond the basic e-mail programs. It includes workgroup tools that help you manage your messages, appointments, contacts, and tasks; track activities; open and view documents; and share information. Exchange Server 5.5 is the server software that supports the functionality of Outlook.

Together Outlook and Exchange can transform messaging in your environment and enhance communication between students, faculty, and staff.

Unlike when you run the Outlook client application independently of Exchange Server, your message store on the server-based mailbox is not a separate single file but instead is a data structure within Exchange Server. There are several very important advantages to using Outlook in conjunction with Exchange Server:

- Your mailbox is backed up as part of any regular Exchange Server backup procedure. If you put your messages in Personal Folders, then you may be responsible for your own backups.

- You can easily access messages in your Exchange Server mailbox from a remote location, without the need to synchronize Personal Folders between desktop and remote locations.

- When you use the Exchange Server mailbox as your main folder location, you can give other Outlook users access to your Calendar, Contacts, and other folders.

Course Prerequisites

This curriculum addresses a number of advanced Outlook functions that are only available to those using Outlook on Exchange Server.

Staff and faculty attending this training are presumed to possess a basic to intermediate familiarity with the Outlook client. Prerequisite knowledge should include using Outlook to send and receive messages and attachments, schedule meetings and appointments in the Calendar, create tasks, create and maintain folders, create contacts, etc.

If you do not possess this knowledge, please contact your IT Director to find out about internal training in the Outlook client at your college.
Using Outlook with Exchange Server in the CT Community College System

Outlook and Exchange Symbols

Inbox symbols:
- High importance message
- Low importance message
- Read message
- Unread message
- Forwarded message
- Replied to message
- Saved or unsent message
- Sealed message
- Digitally signed message
- Microsoft Mail 3.x form

Calendar symbols:
- Appointment
- Click to see calendar items that do not fit in the current view
- Meeting
- Meeting request
- Recurring appointment
- Recurring meeting
- Recurring meeting or appointment
- Reminder for the appointment or meeting
- Private meeting or appointment
- Start and end times of the appointment or meeting

More Inbox symbols:
- Accepted meeting request
- Tentatively accepted meeting request
- Declined meeting request
- Canceled meeting request
- Task request
- Accepted task
- Declined task
- Message is flagged for follow up
- Message is flagged as complete

Exchange symbols:
- Posted message
- Message recall attempt
- Notification of successful message recall
- Notification of unsuccessful message recall
- Notification of a delivered message
- Notification of a read message
- Notification of a message that was not delivered
- Notification of a message that was not read
- Remote Mail message header
- Message marked for download
- Message marked for download

Task symbols:
- Accepted task
- Completed task
- Declined task
- High importance task
- Low importance task
- Recurring task
- Task
- Task assigned to another person
- Task assigned to you
- Task has an attachment

Contacts symbols:
- Activities have been automatically recorded in Journal for this contact
- Contact
- Contact has an attachment
- Contact is flagged for follow up
- Contact is flagged as complete
Using Outlook with Exchange Server in the CT Community College System

Understanding the Address Lists

Most of the address lists you encounter are either personal or organizational, either your own set of addresses or the roster of people in the CCC system. There can be several different address books in the Address Book dialog box including the Outlook Address Book (which includes your personal Contacts list), and the Global Address List (GAL).

When you click on the Address Book and select the Show names from the pulldown list box, you will see a list which includes:

1. The Global Address List (GAL), which is organized first by college, then by department within each college. Your system administrator maintains this list.

The Outlook Address Book which includes your personal contacts (which are always at the end of the list).
**Difference between the Outlook Address Book and Contacts**

When the Address book is opened, it initially shows names from the **Global Address List**. In this view, the names and phone numbers as well as location, position title, etc. are displayed (a horizontal scroll is available) of individuals on Exchange Server’s GAL.

Display the properties of someone in the GAL

- Double-click on a name in the Global Address List to display the GAL Properties box.

Add a person in the GAL to your Personal Address book (Contacts)

- Click on the **Personal Address Book** button in the Properties dialog box. A new contact will be created for the individual. You
might wish to do this if there is ancillary information about that individual (such as personal information, home phone, fax number, notes, etc.) in addition to what is included in their GAL properties.

- The e-mail address in the new contact will be tied to the information stored in the GAL.

Display a list of individuals stored in your personal Contacts

- Click the down arrow in the Show Names from the: field, and select “Contacts”.

- When your personal Contacts are displayed in the Address book, only the individual's name (or distribution lists), type of e-mail account, and e-mail address will be displayed.
Double-clicking on a name in the list displays the entry’s Contact information:
Contacts

A Contact is a person or organization you correspond with. You can store information about contacts such as job titles, phone numbers, addresses, e-mail addresses, Internet e-mail addresses, and notes. When you create a contact, you can start by entering all new information or you can start with information from an existing contact.

TIPS

You can look up information about a contact from an e-mail message, a meeting request, and a task. Right-click the contact name and then click Look up Contact.

To create a contact from an e-mail message you receive, right-click the name in the From field that you want to make into a contact, and then click Add to Contacts.
Categories

A category is a keyword or phrase that helps you keep track of items so you can easily find, sort, filter, or group them. Use categories to keep track of different types of items that are related but stored in different folders.

Categories also give you a way to keep track of items without putting them in separate folders. For example, you can keep professional and personal tasks in the same task list. When you assign them to Categories you can view the tasks separately (on the View menu, point to Current View, and then click By Category). You will find that many of the categories in the Master Category List are geared toward business needs, but it is easy to create your own custom categories for you to use.

Create a new category

2. On the Edit menu, click Categories. If Categories isn’t available, click any Outlook 2000 item (for example, an e-mail message), and then try again.

3. Click Master Category List.
4. In the **New Category** Box, type *My Category* to name the category.

5. Click **Add**.

6. To create more categories, repeat steps 3 and 4.

7. Click **OK**, and then click **OK** again.
Create a new contact and add it to a category

1. On the File menu, point to New and then click Contact. The Contact dialog box appears.

![Contact Dialog Box](image)

2. In the Full Name box, type in the information in the above screen shot.

3. Continue typing in the information to match the information in the fields above.

4. Enter the information you want to include for the contact. There are several tabs on which you can enter information.

5. To assign the contact to the category, click the Categories button at the bottom of the form, and then select My Category from the list.

6. This will put your name into My Category.

7. Click Save and Close.
Send an e-mail to everyone in a category

1. From the **Outlook Shortcut Bar**, click on the **Contacts** icon. The Contact dialog box appears.

2. Select the **By Category** view from the **Current View** dropdown box.

3. Your contacts will be grouped by category, and each category will have it’s own header.
4. Click and drag a category header onto the **Inbox** icon in the Outlook Shortcuts column.
5. A new e-mail message is created, addressed to everyone associated with that category.
Create a new contact from the Outlook Address Book

1. Click **Address Book** on the Standard toolbar. The Address Book dialog box appears.

2. In the Show Names from the drop-down box, select **Outlook Address Book**.

3. Click **New Entry** on the dialog box’s toolbar.

4. In the **Select the entry type** dialog box, select **New Contact**. In the **Put this entry** field, click the down arrow and select **Contacts**, then click **OK**.

5. On the **General** tab, in the **Full Name** box, type *Patty Smith* and then press **Tab**. The contact name is automatically recorded as *Smith, Patty* in the **File As** box.

6. Note: To change the way this name is displayed, choose **Tools > Services > Outlook Address Book > Properties** and select the radio button for the **Show Names By** option that you prefer.

7. In the **E-mail Addresses** box, type *Patty@aol.com* and click the **Save and Close** button.
8. If you want, click the **Business**, **Phone Numbers**, or **Notes** tabs and enter additional information.

9. Click **OK** to save the information.

10. Repeat steps 3 through 8 to add more contacts.
TIP

You can save the address from a received message in the Outlook Address Book (as a new Contact). Open the message and then right-click the sender’s name or e-mail address in the From field. Click Add to Contacts.
Distribution Lists

TIPS

Distribution List (or Groups) - a handy collection of contacts grouped under a single name.

If you frequently e-mail information to the same people, you can also build distribution lists.

A message sent to this distribution list goes to all recipients listed in the distribution list. Recipients see their own names and the names of all other recipients on the To line of the message instead of seeing the name of the distribution list. You can use distribution lists in messages, task requests, meeting requests, and other personal distribution lists.

There are already system-wide and college-specific distribution lists available on the GAL. College-specific distribution lists are in bold, and begin with the college’s two-letter abbreviation. For example, two of Three Rivers’s college-specific distribution lists (TR_AITRCC and TR-Info Technology Division) are shown in the screenshot below:

Personal distribution lists are identified with and are stored by default in the Contacts folder, so you can sort, print, and assign categories to them.

TIP

You can add a distribution list that someone has sent you to your Contacts folder. Open the message that contains the list, click on the list and drag it to Contacts on the Outlook bar or Folder list.
Create a new distribution list in your Contacts

1. On the **Tools** menu, click **Address Book**.

2. Click **New Entry** on the dialog box’s toolbar button.

3. In the **Select the entry type** list, click **New Distribution List**.

4. Under **Put this entry**, click **Contacts** in the list.

5. In the Name box, type: *New Sales Team*. This is the name of your new distribution list in your Contacts folder.

6. Click **Select Members**. In Show names from the list, click **Contacts**, or **Global Address Book**, or whatever address book you want to choose names from.
7. In the **Type name or Select from List** box, type the name of a user that you want to include. In the list below, select the name, and then click **Add**.

8. Repeat step 4 to add the rest of the users you want to include in the distribution list, and then click **OK**.

9. If you want to add a longer description of the distribution list, click the **Notes** tab and then type the text.

10. Click **Save** and **Close**.

The group appears in the Contact list identified by a group icon and the group name is in boldface type.

---

**T I P**

To add an address that is not in the Contact folder or an address book, click **Add New**. To remove a name, select it and click **Remove**.
**Show the members in a personal distribution list**

1. From the **Contacts** Folder, double click the **New Sales Team** contact item; the distribution list of names will appear on the **Members** tab.

![Distribution List](image1.png)

- Or -

2. In a new message, click the **To** field.

3. In the **Show Names from the list** box, click the address book that contains the distribution list you want information about, Select **Contacts** from the list.

4. In the **Type name or Select from List** box, type the name of the distribution list or click the name in the list and Click the **Properties** button.

5. This brings **New Sales Team** to the **Message Recipients** box. The list is then displayed, showing who is included in the distribution list.
Create and send an e-mail message to a distribution list

<table>
<thead>
<tr>
<th>TIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>To send a message on stationery, click on the Actions menu, point to New Mail Message Using, click More Stationery, and then select a background. The New Message window opens.</td>
</tr>
</tbody>
</table>

2. From the main menu, click Actions, click New Mail Message. Or, on the Standard toolbar, click the New Mail Message button . A new message box will appear.

3. In the To field, type the e-mail address of the distribution list. You can type in the name of the distribution list into the To field and it will find it automatically, just as it would if you typed in a person’s name.
4. If you are sending to more than one person, type a comma (,) or a semicolon (;) between the e-mail addresses.
   - Or -
   Clicking the To button opens your address books. Select an address book and double-click a name in it. The address moves to the To Message Recipients field.
5. Repeat step 4 to add more e-mail addresses to the To field.
6. To send a carbon copy (CC) to someone (optional), click the CC field. Type the e-mail address in the field, or click CC, choose an address from one of your address books, and click OK. Repeat to CC other people.
7. To send a **blind carbon copy (BCC)** to someone, (to CC someone without the other message recipients knowing the person received the message) (optional); on the View menu select Bcc Field. **Type the e-mail address in the field**, or click BCC, choose an address from one of your address books, and click OK. Repeat to blind CC other people.

   *Choose any name you wish to appear in the BCC field.*

![Image of Outlook interface with BCC field highlighted]

8. To add a subject line to the message, click in the **Subject** field and then type:

   *Sales Data*

9. Click in the blank field below the Subject field (the message field) and type:

   *Here is the sales information I promised for Monday’s meeting*

10. When you are satisfied with your message, click **Send**. The message automatically moves to your **Outbox** folder and you return to the main **Inbox** window.

11. When the message has been sent, it moves to the **Sent Items** folder. If the message cannot be delivered to someone, you should receive an automatic reply letting you know who could not be reached and why.
Distribution Lists vs. Categories

**T I P S**

With the implementation of Exchange Server and the availability of the **Global Address List**, it may be easier to use distribution lists instead of assigning categories in contacts and then sending an e-mail to everyone in a category. You can’t assign "personal" categories to individuals directly in the Global Address List (GAL). However, you can save an entry displayed in the GAL as a new contact and then assign it to a category. A better method is to set up a distribution list based on the addresses in the GAL. A distribution list is updated automatically upon any change to the GAL, which ensures that all the addresses remain up to date.
Using Outlook with Exchange Server in the CT Community College System

Using Advanced Inbox Features

The following features are now available by using Outlook 2000 with Microsoft Exchange Server:

- **Tracking Messages.** You can track messages that are delivered or read by recipients.
- **Message Recall.** Recall a message from recipients who haven’t read it yet and, if you want, replace the recalled message with a new message.
- **Voting.** Request and tally responses to a multiple-choice question you send in a message. Consolidate voting notifications in the original message.
- **Out of Office Assistant.** Manage e-mail messages while you’re out of the office. Set up an automatic response to incoming messages that lets people know you are away.

**Tracking when messages are delivered or read**

You can track when messages you send are delivered or read by recipients. You receive a message notification as each message is delivered or read. The contents of the message notification are then automatically recorded on the Tracking tab of the original message. You can automatically delete message notifications in your message list.

**To be notified when all messages are delivered**

To change the option to be notified when all messages are delivered, follow the steps below. You will receive a read receipt message for each message that is sent out by you once the user has opened the message. The disadvantage of being notified each time a message is opened is that you will receive a lot of read receipt notices in your e-mail account.

1. On the Tools menu, click Options.
2. Click the Preferences tab.
3. Click E-mail Options and then click Tracking Options.
4. Select the Request a read receipt for all messages I send check box.
Important! If you do not uncheck the option **Request a read receipt for all messages I send**, you risk unnecessarily cluttering up your Exchange Mailbox with receipt messages.
To be notified when only one message is delivered or read

1. On the Actions menu, click New Mail Message.
   - or -
   In Inbox view, click New Message.

2. Type the e-mail addresses of the individuals to whom you want to send the message in the To box separated by semi-colons.
   - or -
   Click the To button and then double-click the individuals from your Contacts or the Global Address List. Click OK.

3. Type the subject of your e-mail in the subject box and then press Enter to move to the body of the message.

4. Type the text of your message in the area provided (you may also change the formatting of the text, include graphics, and attach files).

5. Click the Options button in the new message box.

6. In the Message Options dialog box, select the Request a delivery receipt for this message and/or the Request a read receipt for this message checkbox.
Message recall

You can recall or replace a message sent to a recipient, as long as the message has not been opened, read, or moved out of the Inbox folder.

Recall or replace a message you have already sent

1. If the Folder List is not visible, click the View menu and then click Folder List.
2. Click Sent Items.
3. Open the message you want to recall or replace.
4. On the Actions menu, click Recall This Message.
5. To recall the message, click Delete unread copies of this message.
6. To replace the message with another, click Delete unread copies and replace with a new message, click OK, and then type a new message.

To be notified about the success of the recall or replacement for each recipient, select Tell me if recall succeeds or fails for each recipient.
**Using the Out of Office Assistant**

In a workgroup environment using Microsoft Exchange server, you can use the **Out of Office Assistant** to alert all e-mail correspondents when you will be away or unavailable by e-mail.

Once activated, the Out Of Office Assistant automatically replies with your personal out-of-office message to anyone who sends you an e-mail message during that time. People will receive only one out-of-office message from you while you are away.

The people who correspond with you will automatically receive only 1 Out of Office message from you even if that person sends more than 1 e-mail to you.

**Activate the Out Of Office Assistant**

In this exercise you will activate the Out of Office Assistant to notify others that you will be on vacation.

1. Activate the **Inbox**. Choose **Tools**, then click **Out of Office Assistant**. The Out of Office Assistant dialog box appears.

2. Select the **I Am Currently Out of The Office** option button.

3. In the **AutoReply Only Once To Each Sender With The Following Text** box, type:
   
   *I will be on vacation and unable to access e-mail from Monday, September 17, through Friday, September 21.*
4. Click **OK**.

The Out Of Office Assistant is now activated and will send this response once to the sender of any e-mail message until you deactivate the feature.

**T I P**

To turn off the Out Of Office Assistant when you return to the office, open Outlook and when the message prompting you to turn it off appears, click Yes.
Conducting a Vote

In a workgroup environment, it is possible to conduct a vote, tally the results, and record each person’s response all in one e-mail message file. This is done automatically. It avoids sending an e-mail message to a group, awaiting individual responses, and then tallying each person’s response by hand.

In order to complete this exercise you need to request help from at least two other people on your network that will respond to your message.

Adding voting buttons to your e-mail message

1. On the Outlook Bar, click the Inbox.
3. Click the To button.
4. In the Select Names dialog box, in the Show Names From The drop-down list, select Global Address List.
5. In the name list, scroll to select the names of the two people in your network who agreed to participate in this exercise with you. Click the To button for each name, and click OK.

The Select Names dialog box closes and the participants’ names are listed in the To box on the Message form.

6. In the subject box, type: Weekly Staff Meeting and then in the message area, type:

I will be bringing lunch to our Weekly Staff Meeting. Would you prefer Pizza or Chinese Food?

7. On the Message for Standard toolbar, click the Options button.
8. In the Message Options dialog box, in the Voting and Tracking Options area, click the Use Voting Buttons check box. In the box next to Use Voting Buttons, Approve;Reject appears.
9. In the Use Voting Buttons box, type: Pizza;ChineseFood
10. In the Deliver Options area, be sure that the Save Sent Messages To check box is selected, and that Sent Items appears in the box.
11. Your screen should look similar to the screen shot below:
12. Click the **Close** button, and then, on the Message form Standard toolbar, click the **Send** button.

13. When the recipients opened the message you sent, at the top-left area of the message window they would see two buttons, one labeled **Chinese** and the other labeled **Pizza**, as shown in the two screenshots below:

14. By clicking on one of these buttons, they respond to the person who sent the request, with their choice of food.
**Reviewing survey responses**

As the recipients respond to the e-mail message, the responses are delivered to your Inbox, with each recipient’s voting choice displayed in the Subject column so that you can view responses at a glance.

![Image of Outlook inbox with survey responses]

**Tracking survey results**

The responses you have opened are tracked automatically in your copy of the original message in your Sent Items folder.

1. Double Click to open each response e-mail. This action records the results in the tracking feature in your copy of the original message located in your Sent Items folder.

2. On the Outlook Bar, click the My Shortcut button, and then click the Sent Items shortcut.

3. The message Items in the Sent Items folder are displayed.

4. Double-click the Weekly Staff Meeting message to open.

5. On the Message form, click the Tracking tab.

6. The Tracking tab becomes active, with the total replies summarized in the Comment area. Below this, the response from each respondent is listed.
7. **Close** the message.
Outlook Web Access (OWA) Overview

Outlook Web Access (OWA) provides some of the functionality of Outlook, and makes your mail and calendar available to you from any computer with a Web browser and an Internet connection. It provides Web-based public access to Microsoft Exchange Server public folders and the Address Book. You can log on to your personal account to read private e-mail, send messages, create contacts, and schedule appointments.

Difference between Outlook e-mail client and OWA e-mail client. There is less functionality in OWA. The table below compares the features of both clients.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Outlook</th>
<th>OWA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spell-check</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Tabs</td>
<td>Yes</td>
<td>No – using the Tab key changes the focus of the cursor to toolbar buttons</td>
</tr>
<tr>
<td>Personal distribution lists available in Contacts</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Message size limit</td>
<td>No</td>
<td>Yes (100K limit on text in message box)</td>
</tr>
<tr>
<td>Characters available as message separators</td>
<td>Commas or semi-colons</td>
<td>Semi-colons only</td>
</tr>
<tr>
<td>Archive folders available</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Drafts saved to Drafts folder</td>
<td>Yes</td>
<td>No – drafts can be saved to Inbox, however</td>
</tr>
<tr>
<td>Electronic signatures available</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Shortcut menus</td>
<td>Yes</td>
<td>Yes with Internet Explorer 5.0</td>
</tr>
<tr>
<td>Timed delivery</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Expiration</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Reminders</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Private Items</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Outlook rules</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Logging on to Outlook Web Access

Web Browser Specifications for OWA

Microsoft Outlook Web Access requires a web browser that supports frames and JavaScript, such as Microsoft Internet Explorer 3.0 or greater and Netscape Navigator 3.0 or greater. This is a secure site. The Microsoft Outlook Web Access server uses SSL (Secure Socket Layer) to encrypt the data between your PC and the server for a secure connection. If you have any questions about your browser settings, please contact your local IT administrator.

1. Begin an Internet session as you usually would, and open your web browser of choice. (Note: In this documentation, screenshots from the Internet Explorer browser were used. You may use other browsers instead, if they meet the requirements specified above.)

2. Click into the Address bar and type www.mail.commnet.edu, and press ENTER. Your screen should look like the picture below.

3. In the Log On box, type your e-mail name. For Example, type jdoe@commnet.edu

4. Press ENTER or click the click here hyperlink below the Log On box. The Enter Network Password dialog box will appear.
5. In the **User Name** field, type your NT Domain, followed by a backslash, and then your NT User Name, as follows:

   **Format:** NT domain\your NT user name  
   **Example:** commtech\jdoe

6. If you do not know your domain name and do not recognize it in the table below, contact your administrator.

<table>
<thead>
<tr>
<th>Domain List By College</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>College</strong></td>
</tr>
<tr>
<td>Asnuntuck</td>
</tr>
<tr>
<td>Capital</td>
</tr>
</tbody>
</table>
<pre><code>               | WOODLAND             |
</code></pre>
<p>| Gateway                | GCTC                 |
| GCTCNH                |
| Housatonic             | HCTC                 |
| Manchester             | MCTC                 |
| Middlesex              | BUTTERFLY            |
| MERIDEN               |
| Naugatuck Valley       | NVCTC                |
| Northwestern           | NWCTC                |
| Norwalk                | NCTC                 |
| Quinebaug Valley       | QVCTCA               |
| QVCTCW                |
| System Office          | COMMTECH             |
| FLATBUSH_LAB          |
| Three Rivers           | STARS                |
| Tunxis                 | TXNT                 |</p>
Using Outlook with Exchange Server in the CT Community College System

7. Press **TAB** to move to the **Password** box, and type your NT password (remember it is case sensitive).

   The **Enter Network Password** dialog box should now look as follows:

   ![Enter Network Password dialog box](image)

8. Click **OK**.
View your folders in Outlook Web Access

The interface you see in Outlook Web Access has the same familiar layout of Outlook, but lacks the Outlook main menu bar. All of the features of Outlook Web Access are available through the toolbar.

The Outlook Web Access toolbar

1. To access your mailbox folders double click the up one folder button.
2. Your Exchange Mailbox folder will be displayed, as shown below.

![Exchange Mailbox folder](image.png)

**Changing pages**

The **Page** box is located on the toolbar. It lists the total number of pages of messages that are in the current folder, and indicates which page is currently displayed. The list of messages is longer than can be displayed on one page of the viewer at once.

![Page box](image.png)

To display a different page, do one of the following:

- To display a specific page, click the first number (in the **Page** box), type the page number, and then click **Page**, or press the **Enter** key.

- To display the previous page, click **Previous Page**.

- To display the next page, click **Next Page**.
Delete e-mail messages

To delete an e-mail message from the Inbox, click in the checkbox to the left of the e-mail message for each item you want deleted, and click the delete marked items button on the toolbar.

**TIP**

You create e-mail messages, calendaring, contacts and tasks all the same way as in Outlook.

OWA does not support marking something private.

**Important: Remember to Log Off!**

If you were checking your mail through Web Access at another computer other than your own, and you do not log off, anyone can view your mail! Log off after you finish using Outlook Web Access. By logging off, you close the session between the client and the server. *If you close only the Web browser, there is no guarantee that your session is closed.*
Outlook 2000 Folder Permissions

If the system administrator or technology coordinator has set up a public folder, you may have permission to use some or all of the folders within the public folder. If someone has shared one of their private folders with you, then you have permission to perform certain activities in that folder. The extent of the activities you can perform in a public folder or a shared private folder (that you have permission to open) depends on your role (or combination of permissions) in that folder:

**Owner.** Create, read, modify, and delete all items and files and create subfolders. As the folder owner, you can change the permission levels others have for the folder.

**Publishing Editor.** Create, read, modify, and delete all items and files, and create subfolders.

**Editor.** Create, read, modify, and delete all items and files.

**Publishing Author.** Create and read items and files, create subfolders, and modify and delete items and files you create.

**Author.** Create and read items and files, and modify and delete items and files you create.

**Reviewer.** Read items and files only.

**Contributor.** Create items and files only. The contents of the folder do not appear.

**Custom.** Perform activities defined by the folder owner.

**None.** Cannot open the folder; you have no permissions.
Assign delegate access and folder permissions

Delegate access and folder permissions. Give another person delegate access permission to work in your Microsoft Outlook 2000 folders and to send messages on your behalf. Or, assign a colleague permission to read, modify, or create items in your public and private folders on a Microsoft Exchange Server computer.

Granting permissions to a delegate

1. On the Tools menu, click Options. - The Options dialog box opens.

![Options dialog box](image)
2. Click the **Delegates** tab.

![Delegates tab screen shot](image)

3. Click the **Add** button to open the **Add Users** dialog box.

![Add Users dialog box](image)

4. In the **Add Users** dialog box, in the **Show Names From The** box, be sure **Global Address List** is selected. Select your coworker's name.
from the global address list, click **Add**, and click **OK**.

![Delegate Permissions dialog box](image)

5. **The Delegate Permissions** dialog box opens with your coworker’s name displayed on the title bar.

6. In the **Delegate Permissions** dialog box, your coworker is automatically assigned **Editor permissions** in the **Calendar** and **Tasks** boxes.

7. In the **Calendar** area, be sure that the **Delegate Receives Copies Of meeting-Related Messages Sent To Me** check box is selected.

8. Click the **Inbox** drop-down arrow, and then select **Editor**.

9. Select the **Automatically Send A Message To Delegate Summarizing These Permissions** check box, and then click **OK**.
10. On the **Delegates** tab, be sure the **Send meeting request and responses only to my delegates, not To me** checkbox is selected.

![Delegates Tab]

11. Click the **OK** button at the bottom of the Options dialog box.  
*The Options dialog box closes. Your coworker has been granted delegate permissions and will automatically receive a subscription invitation in his or her Inbox.*

12. The recipient must click the **Accept** button to subscribe.  
The **Folder** then appears in the **subscriber's Outlook Folder list**, but is accessible only to subscribers. Recipients not using Outlook receive a notification message instead of a subscriptions invitation.
13. The message that your coworker receives should look similar to the screen shot below.

![You have been designated as a delegate for Young, Gary - Message...](image)

**Send a message as a delegate**

In this exercise, you have been granted delegate permissions as Editor in your coworker’s Inbox folder, and you send an e-mail message on your behalf.

1. On the Outlook Bar, click the **Inbox** shortcut. The contents of the Inbox are displayed in the Information viewer.

2. On the **File** menu, point to **Open**, and then click **Other User’s Folder**. The **Open Other User’s Folder** dialog box opens.

3. In the **Open Other User’s Folder** dialog box, click the **Name** button. The coworker’s name is displayed in the **Name** box.

4. In the **Select Name** dialog box, type the name of your coworker, and click **OK**, or select it from the list. The coworker’s name is displayed in the **Name** box.

5. In the **Folder** box, be sure that Inbox is selected, and click **OK**. Your coworker’s Inbox appears as a window on your screen, and any mail is displayed in the window. Your screen should look similar to the following illustration.
6. In your coworker’s Inbox, maximize the window, and then in the Information viewer, double-click a message. The message opens.

7. On the Message form Standard toolbar, click the Reply button. A blank Message form appears, with the original sender’s name in the To box.

8. Type a reply to the message, and then click the Send button. Your message is sent. The message the recipient receives should look similar to the picture below:
Open a coworker’s calendar

To view a coworker’s calendar, open it by following steps 1 through 5 in the Send a message as a delegate instructions, but change #5 in the instructions to:

5. In the Folder box, be sure that Calendar is selected, and click OK.

Your coworker’s Calendar appears as a window on your screen, and any appointments and meeting that are public are displayed in the window.

Assign or deny a Delegate permissions to your contacts

1. From the Main Menu, choose Tools, Options, click the Delegates tab.

2. To decide whether or not to provide the user access to your Contacts that you have marked Private, check or leave unchecked the delegate can see my private items checkbox.
Setting Folder Permissions

For this exercise it is best to turn on **Folder View**:
- From the Main Menu choose **View**, then **Folder View**.

**Share a folder with coworkers**

For this exercise, we will share the **Notes** folder.

1. In the Folder List, right-click the **Notes** folder, and on the shortcut menu, click **Properties**. The **Notes Properties** dialog box opens.

2. In the **Notes Properties** dialog box, click the **Permissions** tab.

3. On the **Permissions** tab, click the **Add** button. The **Add Users** dialog box appears.
4. In the **Add User** dialog box, select the name of the coworker to whom you wish to grant access, click the **Add** button, and click **Ok**. The **Notes Properties** dialog box appears.
5. In the **Notes Properties** dialog box, in the **Name Role** list, select the name of the coworker.

6. In the **Roles** drop-down list, select **Author**, and click **OK**.

7. The **Notes Properties** dialog box closes and the coworker has **Author** Privileges in your **Notes** folder.

---

**TIPS**

To share another folder with the same coworker, repeat steps 1 through 6. Each time, right-click the folder you want to share.
Revoke folder-sharing permissions for a coworker

In this exercise, you will remove permission for your coworker to share your folder.

1. Select the **Notes** folder from the Folder List.

2. In the Folder List, right-click the **Notes** folder, and then on the shortcut menu, click **Properties**. The **Notes Properties** dialog box opens.

3. In the **Notes Properties** dialog box, click the **Permissions** tab.

4. On the **Permissions** tab, select your coworker's name from the list, click the **Remove** button and click **OK**.
Using the Calendar

**Appointments** are activities that you schedule in your Calendar that do not involve inviting other people or reserving resources. You can set reminders for your appointments and you can schedule recurring appointments. You can also specify how others view your Calendar by designating an appointment as busy, free, tentative, or out of office. **Appointments can also be made private.** If you will be granting permissions to others in your organization to view your calendar, it's a good idea to get into the habit of marking items (such as doctors appointments or personal meetings) as private.

A **meeting** is an appointment you invite people to or reserve resources for. When you create a meeting, you identify the people to invite and the resources to reserve, and you pick a meeting time. Responses to your meeting request appear in the Inbox folder. To track responses, open a meeting and then click **Show attendee status** on the Attendee Availability tab in the **Meeting** dialog box. You can also add people to an existing meeting or reschedule a meeting.

An **event** is an activity that lasts 24 hours or longer. Examples of an event include a vacation or a conference. An annual event, such as a birthday or anniversary, occurs yearly on a specific date, while a standard event occurs once and can last for one day or several days. Events and annual events do not occupy blocks of time in your Calendar; instead, they appear in banners.

**Schedule a private appointment**

When you schedule an appointment, you have several options for it, such as setting the appointment to be recurring (for events like faculty meetings that may take place weekly) or having Outlook 2000 remind you about an appointment before it occurs.

1. Click the **Calendar** folder to open it.
   You should see the one-day view for the current day.

2. Click a **date** in the mini month calendar to the right of the Daily view calendar.
   Choose March 4, 2002

3. In the appointment area select the 9:00 AM to 10:00 AM time slots.
   The box turns blue.

4. On the **Standard** toolbar, click the **New Appointment** button:

   ![New Appointment button](image)

   *The Appointment form appears. The date and time boxes are already filled in.*

5. In the **Subject** box, type text describing the appointment.
   Type: **See Dr. Brown**
6. In the Location box type: *His Office*

7. In the Comment area, type: *Annual Physical Exam*

8. On the Appointment form, in the lower-right corner, select the **Private** check box.

9. Click **Save and Close**.
   
   *You return to the Calendar folder’s main window.*

10. Notice that the date on which you made the appointment now appears bolded in the mini month calendar.
Schedule a recurring appointment

When you schedule an appointment, you have several options for it, such as setting the appointment to be recurring (for events like staff meetings that may take place weekly) or having Outlook 2000 remind you about an appointment before it occurs.

1. Click Calendar on the Views bar and then click New Recurring Appointment from the Actions menu.

2. To schedule your weekly staff appointment, type the Start time and End time as appropriate and make sure the boxes beside the appropriate days are checked.

3. You do not anticipate that this schedule will change so leave No End Date selected and then click OK.

4. Type Weekly Staff Meeting in the Subject box and then click Save and Close.
Change the view of appointments

1. In the Calendar folder, on the View menu, point to Current View.
2. A submenu appears.
3. On the submenu are several options for viewing your appointments.
4. Select one of the following:
   5. Day/Week/Month
   6. Day/Week/Month View with AutoPreview
   7. Active Appointments
   8. Events
   9. Annual Events
   10. Recurring
   11. By Category

Schedule a meeting

1. From the Actions menu, click Plan a Meeting and then click the Invite Others button.
2. Click the New Sales Team from the Global Address List and Click OK.
3. View the busy times of the proposed attendees and click AutoPick to have Outlook find the best time based on the options in the drop down list.
4. If you want to see the members of the **New Sales group** individually, click the + to the left of the group name and the list will be expanded. **The list will be replaced with its members.** This process is not reversible.

5. Adjust the **Begin** and **End** times to schedule the meeting for tomorrow from 10:00 am to 12:00 pm and then click **Make Meeting**.

6. Type **New Sales kick-off** in the **Subject** box and then click **Send**.

7. The users are sent an e-mail message indicating your request for a meeting and are given the opportunity to accept or decline the invitation.

8. You can double-click the meeting and then select the **Attendee Availability** tab to view the list of responses or to add individuals to the meeting.
Using Outlook with Exchange Server in the CT Community College System

**Determining the Size of an Outlook Folder**

The E-mail Standards Committee has set a limit that individual Outlook accounts cannot be larger than 40,000 kilobytes.

When your account goes over that limit, you will receive an automatic message informing you that your account is too large. You can either archive information that you want to keep, or begin deleting unnecessary messages, files and/or folders.

The best way to check the size of your Outlook Account is to look at the properties of the Outlook Today Icon.

1. Right-click the Outlook Today Icon on the Outlook Shortcuts toolbar, and then click Properties on the shortcut menu.

   ![Outlook Properties Dialog Box]

2. Click Folder Size.
3. If the information in **Total Size (Fld+SubFld)** field is greater than **40,000K**, your account is too large, and you will get a message from the Systems Administrator:

4. Subject: Your mailbox is over its size limit

5. If it is less than 40000K, you will receive no message.

6. If more than 40000K, you should archive or delete some messages.

**TIPS**

To find messages that are taking up a lot of space in your Exchange mailbox, try doing an advanced find, searching for items that are >50K in size. Then either delete those items, or move them to your archive folders. Or you could use the Rules Wizard to automatically move your sent items to the **Sent** folder in your Archives, rather than to the **Sent** folder in your Exchange mailbox.
Archiving Outlook Folders

Archiving is a method of saving old Outlook information that you might need later but will not use often, enabling you to avoid the clutter of these older items and keeps the size of your Outlook account down to a minimum.

It is recommended that you use AutoArchive to establish a systematic method of archiving your files automatically.

Your Outlook mailbox grows as items are created in the same way that papers pile up on your desk.

The E-mail Standards Committee has set a limit that individual Outlook accounts cannot be larger than 40,000 kilobytes. When your account becomes close to this size, an automatic message will be sent to your account informing you that your account is too large. You can either manually archive information that you want to keep, or begin deleting unnecessary messages and folders.

You can manually transfer old items to a storage file by clicking Archive on the File menu, or you can have old items automatically transferred by using AutoArchive. Items are considered old when they reach the age you specify.

With AutoArchive, you can either delete or move old items. Outlook can archive all types of items, but it can only locate files that are stored in an e-mail folder, such as a Microsoft Excel spreadsheet or Word document attached to an e-mail message. A file that is not stored in a, e-mail folder cannot be archived.

AutoArchive is a two-step process. First, you turn on AutoArchive. On the Tools menu, click Options, click the Other tab, and then click AutoArchive. Second, you set the AutoArchive properties for each folder that you want archived. At the folder level, you can determine which items are archived, and how often they are archived. You can automatically archive individual folders, groups of folders, or all Outlook folders. The process runs automatically whenever you start Outlook. The AutoArchive properties of each folder are checked by date, and old items are moved to your archive file. The default setting specifies that items in the Deleted Items folder are deleted.

Several Outlook folders are set up with AutoArchive turned on. These folders and their default aging periods are Calendar (6 months), Tasks (6 months), Journal (6 months), Sent Items (2 months), and Deleted Items (2 months). Inbox, Notes, Contacts, and Drafts do not have AutoArchive activated automatically.
Using Outlook with Exchange Server in the CT Community College System

**Turn on AutoArchive**

1. On the Tools menu, click **Options**, and then click the **Other** tab.
2. Click **AutoArchive**.
3. To set **AutoArchive** to turn on when you start Outlook, select the **AutoArchive every** check box.
4. To specify how often the AutoArchive process will run, enter a number in the **days** box.
5. To be notified before the items are archived, select the **Prompt before AutoArchive** check box.
6. In the **Default archive file** box, type a file name for the archived items to be transferred to, or click **Browse** to select from a list.
7. Now that you have turned on AutoArchive, you must set AutoArchive properties for each folder to activate AutoArchive.

**Set AutoArchive properties for a folder**

1. Right-click the folder you want to AutoArchive, and then click **Properties** on the shortcut menu.
2. Click the **AutoArchive** tab.
3. To enable automatic archiving of this folder, select the **Clean out items older than** check box.
4. To specify when items should be automatically transferred to your archive file, enter a number in the **months** box.
5. To specify a file for the archived items to be transferred to, click **Move old items to**.
6. In the **Move old items to** box, type a file name for the archived items, or click **Browse** to select from a list.

**Note**  To activate AutoArchive, on the Tools menu, click **Options**, click the **Other** tab, and then click **AutoArchive**.

**Retrieve archived items**

You can retrieve items from an archive file either by importing the archive file or by opening the archive file. If you import the archive file, you move all the archived items back into your mailbox, into the folders from which they were archived. You can also choose to import the archived items into a new folder. If you open the archive folder, it is added to your folder list, and you can manually copy items into the appropriate folders.

- To open the archive file, choose **File > Open** and then locate your archive file (which may be named Archive.pst but may also have some other file name).
Once the archive file has been opened, it will show up in your folder list. First your archive file’s folders will be displayed, and below that, your Exchange Mailbox folders will be displayed, as follows:

- The Archive Folders and subfolders are displayed first in the folder list.
- The Exchange Mailbox folders are displayed second in the folder list.
Creating Rules to Automatically Organize and Manage Your Inbox

A rule is a set of conditions and actions for processing and organizing your e-mail messages. **Conditions** identify messages for processing, and **actions** determine what kind of processing is performed. Here are some examples of rules you can create:

- Move all e-mail messages I send automatically to my Archive Folder not the Sent Messages folder (this cuts down the size of your Exchange Mailbox Account).
- Set up a notification, such as a message or a sound, when important messages arrive.
- Delay delivery of messages by a specified amount of time.
- Redirect an e-mail message to a person or distribution list.
Move sent messages to an archived folder upon receipt

By creating the rule that all messages go to an archived folder and not the Sent Items folder, will help to keep the size of your mail account smaller.

1. Open Outlook 2000 and click the Inbox folder to display its contents.


3. Click New. The Rules Wizard displays a list of the different types of rules you can create along with a description of the rule in the Rule description box.

4. Select the Move messages I send to someone rule and click Next.

5. Click specified and then click Next.
6. Click on the subfolder in your Archive Folder where you wish to have the messages sent, then click Next.

7. In the Rules Wizard dialog box, click on people or distribution list.

8. Double click on all names from the Name box that the rule should apply to and click OK.

9. Click Next two times from the Rules Wizard dialog box.

10. From the Rules Wizard dialog box, click into the Please specify a name for this rule box and type: Send files to Archive Folder
11. Click **Finish**, and then click **OK**. The rule is added to the Rules Wizard list.
12. Your screen should look like the screen shot below.

![Rules Wizard dialog box]

Apply rules in the following order:
- Send Files to Archive Folder

Rule description (click on an underlined value to edit it):
- Apply this rule after I send the message
- sent to Patty Smith
- move a copy to the Archive Folder folder

13. Click on OK to close the dialog box.
Automatically move or delete items in an Outlook folder after a specified period of time

1. Create a folder or use an existing one.

2. Highlight the folder, right-click and select Properties.

3. Choose the AutoArchive property tab.

4. Check the Clean out item older than (X number) of (Time).

5. Choose either Move items to or Permanently delete old items.
Create a public folder

Note: This is an advance feature that the CCC system will implement only after all faculty and staff have been moved to Exchange.

To create a public folder, you must have permission to create folders in an existing public folder. For information about how to obtain permission, see the system administrator or technology coordinator.

1. On the File menu, point to New and then click Folder.
2. In the Name box, enter a name for the folder.
3. In the Folder contains box, click the type of item you want the folder to contain.
4. In the Select where to place the folder box, click the public folder you want your new public folder to appear in.

Share a schedule, contact list, or task list in a public folder

To share a schedule, contact list, or task list with a group, you must have permission to read items.

Share a task list

1. Set up a public folder.
2. If you create a new Tasks folder instead of copying an existing Tasks folder, be sure to select Tasks as the type of item you want the folder to contain.
3. Add tasks to the task list.
4. Send a link to the public folder in an e-mail message to those whom you gave permission to use the folder. Do this by right-clicking the folder and then clicking Send link to this folder.

You cannot create a task request from a public folder. When you add tasks to a public folder, don’t create a task request from a private folder to assign a task to the public folder. If you do, the due date for the task will not be visible.

Add an existing item to a public folder

1. If the Folder List is not visible, click the View menu and then click Folder List.
2. Click Public Folders and then locate the public folder you want to add the existing item to.
3. Open the folder that contains the item you want to add to the public folder.
4. Click the right mouse button to highlight and drag the item to the public folder in the Folder list, or from the Shortcut menu, click **Copy** or **Move**.

**Post information in a public folder**

1. Open the public folder you want to post information in.
2. To use the default form for posting information, click the File menu, point to New and then click Post in This Folder.
3. Enter the information you want to post in the form.
4. Click Post.

You can also move or copy a file or an e-mail message to a public folder to post information.

**Post a reply to information in a public folder**

1. Open the public folder that contains posted information you want to reply to.
2. Open the item or file you want to post a reply to.
3. To use the default form to reply to posted information, click the Actions menu, and then click Post Reply to Folder.
4. Enter the information you want to post in the form.
5. Click Post.